
HƯỚNG DẪN ÔN TẬP KIỂM TRA CUỐI HỌC KÌ 2 NĂM 24_25 

Câu 1: Để tạo danh sách liệt kê có thứ tự, ta chọn nút lệnh 

A. Numbering. B. Bullets. C. Home. D. Insert. 

Câu 2. Để đánh số trang, ta chọn: 

A. Header  B. Footer. C. Text box. D. Page Number. 

Câu 3. Để bỏ chân trang, ta mở thẻ Insert, chọn nút lệnh Footer rồi chọn 

A. Remove Header. B. Remove Footer. C. Remove Page Numbers. D. Remove Page Design. 

Câu 4: Mỗi đơn vị trong danh sách dạng liệt kê được tạo ra khi người dùng nhấn phím? 

A. Space  B. Enter  C. Tabs  D. View 

Câu 5: Nhóm lệnh Header & Footer nằm trong thẻ: 
A. Home  B. Data  C. Insert  D. Help 

Câu 6: Trong các màu dưới đây, đâu là nhóm màu nóng? 
A. Đỏ, cam, vàng,…    B. Xanh, tím,…. 

C. Trắng, đen, be,…    D. Xanh, vàng, trắng,… 

Câu 7: Nút lệnh nào dùng để tạo liên kết trong trang chiếu? 
A. Insert/Picture.    B. Insert/Hyperlink.  

C. Animations/Hyperlink.   D. Review/Hyperlink. 

Câu 8: Để chọn nội dung thêm vào chân trang chiếu, ta sử dụng thẻ nào: 

A. Date & Time. B. Fixed.  C. Slide number. D. Footer. 

Câu 9: Để trình chiếu từ trang đầu ta ấn phím sau đây trên bàn phím: 

A. Enter  B. F5  C. Insert  D. Ctrl+F4. 

 

Câu 10: Nút lệnh Create  có chức năng gì? 
A. Tạo bản mẫu.   B. Áp dụng mẫu định dạng cho trang chiếu được chọn. 

C. Chọn ảnh minh họa.  D. Thay đổi thứ tự trang chiếu. 

Câu 11: Khi đang làm việc với PowerPoint, muốn thiết lập mẫu bố trí của trang chiếu, ta sử dụng 

lệnh: 

A. Insert → Slide Layout   B. View → Slide Layout 

C. Home → Slide Layout   D. File → Slide Layout 

Câu 12: Có mấy bước để sử dụng bản mẫu trong phần mềm trình chiếu? 

A. 4 bước.  B. 5 bước.  C. 6 bước.    D. 7 bước. 

Câu 16. Khi đang làm việc với PowerPoint, muốn xóa bỏ một trang chiếu ta dùng phím nào? 

A. Delete   B. F5    C. Alt   D. Ctrl 

Câu 13: Để tạo biến trong chương trình Scratch ở nhóm lệnh Variables em chọn lệnh nào sau? 

A. My variable     C. Make a list 

B. My a Block      D. Make a variable 

Câu 14: Đại lượng được đặt tên dùng để lưu trữ dữ liệu, có giá trị không đổi trong suốt quá trình 

thực hiện chương trình được gọi là: 

A. Tên   B. Từ khóa   C. Biến   D. Hằng  

Câu 15: Ngôn ngữ lập trình là gì? 
A. Ngôn ngữ dùng để viết một chương trình máy tính  C. Các dãy bit  

B. Ngôn ngữ dùng để viết các chương trình máy tính   D. Chương trình dịch 

Câu 16: Có mấy bước tạo biến trong Scratch? 

A. 3 bước. B. 4 bước. C. 5 bước. D. 6 bước. 

Câu 17. Cấu trúc rẽ nhánh có mấy loại? 

A. 1     B. 2     C. 3      D. 4 

Câu 18. Đâu là cấu trúc rẽ nhánh dạng thiếu? 

A. IF <Điều kiện> THEN <Câu lệnh) ELSE <Câu lệnh>   

B. IF <Câu lệnh> ELSE <Câu lệnh>  THEN <Điều kiệu> 

C. IF <Điều kiện> THEN <Câu lệnh> 

D. IF <Câu lệnh> THEN <Điều kiện> 

Câu 19. Đâu là cấu trúc rẽ nhánh dạng đủ? 



A. IF <Điều kiện> THEN <Câu lệnh) ELSE <Câu lệnh>   

B. IF <Câu lệnh> ELSE <Câu lệnh>  THEN <Điều kiệu> 

C. IF <Điều kiện> THEN <Câu lệnh> 

D. IF <Câu lệnh> THEN <Điều kiện> 

Câu 20. Trong chương trình Scratch phép toán  gọi là: 

A. Phép chia     C. Phép toán chia lấy phần dư 

B. Phép chia lấy phần nguyên   D. Phép làm tròn 

Câu 21. Trong chương trình Scratch phép toán  gọi là: 

A. Phép toán số học    C. Phép toán so sánh 

B. Phép toán logic (phép và)   D. Phép toán logic (phép hoặc) 

Câu 22. Trong chương trình Scratch phép toán  gọi là: 

A. Phép toán làm tròn    C. Phép toán so sánh 

B. Phép toán logic (phép và)   D. Phép toán logic (phép hoặc) 

Câu 23: Vì sao cần đánh số trang: 
A. Để người đọc phân biệt các trang  B. Để cho đẹp 

C. Để người đọc dễ theo dõi   D. Để tăng dung lượng của file 

Câu 24: Sử dụng danh sách dạng liệt kê giúp: 

A. Tăng chiều dài của văn bản. 

B. Sửa chữa các phần mềm bị lỗi. 

C. Cấu trúc văn bản rõ ràng, mạch lạc, giúp người đọc dễ theo dõi, văn bản có tính thẩm mĩ hơn. 

D. Các trang chiếu đẹp, dễ theo dõi hơn.  

Câu 25: Các thông tin đặt trong phần đầu trang và chân trang có đặc điểm: 

A. Chứa những thông tin quan trọng  B. Tự động xuất hiện ở tất cả các trang 

C. Chứa hình ảnh minh họa   D. Đáp án khác 

Câu 26: Đâu không phải là tác dụng của việc trình bày trang chiếu? 
A. Tạo ấn tượng, thu hút sự quan tâm. 

B. Người nghe nhanh chóng tiếp nhận được nội dung tóm tắt của trang trình chiếu. 

C. Dễ nhìn, dễ theo dõi. 

D. Tính toán tự động. 

Câu 27: Phát biểu nào là sai về sử dụng màu sắc trên trang chiếu? 
A. Cần đảm bảo độ tương phản giữa màu chữ và màu nền. 

B. Các màu nóng thường được sử dụng để làm nổi bật, thu hút sự chú ý của người xem. 

C. Các màu trắng, đen kết hợp với màu nóng hoặc màu lạnh thường tạo sự hài hòa, trang nhã. 

D. Càng sử dụng nhiều màu sắc trên trang chiếu càng tốt. 

Câu 28: Đặc điểm của văn bản trên trang chiếu là gì? 

A. Ngắn gọn.     B. Chỉ nêu ý chính. 

C. Màu sắc hài hòa, cỡ chữ cân đối.  D. Cả 3 đáp án trên. 

Câu 29: Khi muốn sử dụng bản mẫu để làm một bài thuyết trình trong giáo dục, em sẽ chọn bản 

mẫu theo từ khóa nào là phù hợp?  

A. Nháy chuột chọn File/New, nhập từ khóa “Business”, chọn bản mẫu. 

B. Nháy chuột chọn Insert/New, nhập từ khóa “Education”, chọn bản mẫu 

C. Nháy chuột chọn File/New, nhập từ khóa “Education”, chọn bản mẫu 

D. Nháy chuột chọn Home/New, nhập từ khóa “Education”, chọn bản mẫu.. 

 

Câu 30: Phát biểu nào sau đây đúng khi phân biệt bản mẫu và mẫu định dạng: 

A. Mẫu định dạng được thiết kế phù hợp với bản mẫu. 

B. Mẫu định dạng được thiết kế sẵn theo chủ đề. Bản mẫu được thiết kế phù hợp với chủ đề trình chiếu. 

C. Bản mẫu được thiết kế sẵn theo chủ đề. Mẫu định dạng được thiết kế phù hợp với chủ đề trình chiếu. 

D. Mẫu định dạng được thiết kế sẵn theo bản mẫu. 



 

Câu 31: Khi muốn sử dụng bản mẫu để làm một bài thuyết trình trong kinh doanh hoặc trong 

các cuộc họp, hội nghị, em sẽ chọn bản mẫu theo từ khóa nào là phù hợp?  

A. Nháy chuột chọn File/New, nhập từ khóa “Business”, chọn bản mẫu. 

B. Nháy chuột chọn Insert/New, nhập từ khóa “Education”, chọn bản mẫu 

C. Nháy chuột chọn File/New, nhập từ khóa “Education”, chọn bản mẫu 

D. Nháy chuột chọn Home/New, nhập từ khóa “Education”, chọn bản mẫu 

 

Câu 32: Bản mẫu có công dụng như nào? 

A. Chứa bố cục, màu sắc, phông chữ, hiệu ứng, kiểu nền,… và cả nội dụng. 

B. Giúp bài trình chiếu có giao diện thống nhất, chuyên nghiệp mà không tốn thời gian. 

C. Gợi ý các nội dung cần có cho bài trình chiếu; có thể chỉnh sửa, chia sẻ, tái sử dụng bản mẫu. 

D. Cả 3 đáp án trên. 

Câu 33: Khi muốn sử dụng bản mẫu để làm một bài thuyết trình trong giáo dục, em sẽ chọn bản 

mẫu theo từ khóa nào là phù hợp?  

A. Nháy chuột chọn File/New, nhập từ khóa “Business”, chọn bản mẫu. 

B. Nháy chuột chọn Insert/New, nhập từ khóa “Education”, chọn bản mẫu 

C. Nháy chuột chọn File/New, nhập từ khóa “Education”, chọn bản mẫu 

D. Nháy chuột chọn Home/New, nhập từ khóa “Education”, chọn bản mẫu 

 

Câu 34: Apply to selected slides là câu lệnh nào? 

A. Mở bản mẫu.   B. Áp dụng mẫu định dạng cho trang chiếu được chọn. 

C. Chọn ảnh minh họa.  D. Thay đổi thứ tự trang chiếu. 

Câu 35. Biến không nhận dữ liệu kiểu nào? 

A. Kiểu số.   B. Kiểu chữ.   C. Kiểu logic.  D. Kiểu hình ảnh 

Câu 36.Thuật toán tính chu vi hình tròn là thuật toán: 
A. Thuật toán tìm kiếm nhị phân.    C. Thuật toán sắp xếp. 

B. Thuật toán sắp xếp nổi bọt.    D. Thuật toán tuần tự. 

Câu 37:  Kiểu dữ liệu của biến a là:  

A. Kiểu logic   B. Kiểu chữ.  C. Kiểu số   D. Kiểu hình ảnh 

Câu 38: Kiểu dữ liệu của biến a là:  

A. True, false  B. Kiểu chữ.   C. Kiểu logic  D. Kiểu hình ảnh 

Câu 39: Kiểu dữ liệu của biến a là:  

A. Kiểu logic  B. Kiểu số.  C. Số nguyên, số thực D. Số nguyên 

 

Câu 40: Phát biểu nào sau đây có thể lấy làm biểu thức điều kiện trong cấu trúc rẽ nhánh ? 

A. A + B  B. A > B  C. N mod 100  D. “A nho hon B” 

Câu 41. Đâu không phải là phép toán logic trong phần mềm Scratch? 

A. Phép hoặc.  B. Phép và.  C. Phủ định.  D. Phép làm tròn. 

Câu 42. Biểu thức là gì? 

A. Là các lệnh viết bằng ngôn ngữ lập trình chỉ dẫn máy tính thực hiện các bước của thuật toán. 

B. Là một vùng trong bộ nhớ, được đặt tên và được dùng để lưu trữ dữ liệu khi thực hiện chương trình. 

C. Là đại lượng có giá trị không đổi trong quá trình thực hiện chương trình. 



D. Là sự kết hợp của biến, hằng, dấu ngoặc, phép toán và các hàm để trả lại giá trị thuộc một kiểu dữ 

liệu nhất định. 

Câu 43: “Thuật toán tìm số lớn hơn trong hai số a, b”. Đầu ra là: 

A. hai số a, b  B. số lớn hơn  C. số bé hơn  D. số bằng nhau 

Câu 44: “Thuật toán tìm số bé hơn trong hai số a, b”. Đầu ra là: 

A. hai số a, b  B. số lớn hơn  C. số bé hơn  D. số bằng nhau 

 

Dạng đúng sai  

Câu 1: Bạn Minh được giao thực hiện một bài báo cáo về một chuyến đi ngoại khóa. Bạn Minh sử 

dụng phần mềm soạn thảo MS Word để thực hiện. Trong quá trình thực hiện bạn Minh cso sử dụng 

dang sách dạng liệt kê. Hãy đánh giá tính đúng sai của các nhận định sau: 

A. Bạn Minh sử dụng câu lệnh Numbering để danh sách dạng liệt kê có thứ tự trong trình bày văn bản.  

B. Bạn Minh sử dụng câu lệnh Numbering để danh sách dạng liệt kê bằng kí hiệu đầu dòng trong trình 

bày văn bản.  

C. Sử dụng danh sách dạng liệt kê trong trình bày văn bản giúp văn bản có cấu trúc rõ ràng, mạch lạc 

hơn.  

D. Mỗi đơn vị trong danh sách dạng liệt kê được tạo ra khi bạn Minh nhấn phím Enter. Đ 

Câu 2: Nhóm bạn Hân thuyết trình nội dung về di tích lịch ở TP  Hồ Chí Minh. Bạn Hân sử dụng phần 

mềm trình chiếu MS Powerpoint để thực hiện. Trong quá trình thực hiện để bài thuyết trình được hấp 

dẫn nhóm bạn Minh thống nhất trình bày như sau. Hãy đánh giá tính đúng sai của các nhận định sau: 

A. Cỡ chữ nội dung văn bản trong trang chiếu là 44.  

B. Màu nền và màu chữ phải tương phải có sự tương phản.  

C. Văn bản trên trang chiếu càng chi tiết, đầy đủ càng tốt.  

D. Nhóm bạn sử dụng  nhiều màu sắc cho văn bản trên trang chiếu càng giúp thu hút người nghe và  tập 

trung hơn vào bài thuyết trình.  

Câu 3: Bạn Trang được giao bài tập tính tổng 5 số tự nhiên nhập từ bàn phím. Trong quá trình thực 

hiện bạn Trang phải sử dụng câu lặp đi lặp lại 5 lần khối lệnh nhập giá trị và tính tổng. Bạn Hoàng đã 

nói với bạn Trang hãy sử dụng Cấu trúc lặp trong chương trình. Hãy đánh giá tính đúng sai của các 

nhận định sau: 

A. Cấu trúc lặp gồm 2 khối lệnh lặp thường dùng là: Lặp với số lần biết trước và lặp với số lần chưa 

biết trước.  

B. Điều kiện lặp xác định khi nào vòng lặp kết thúc. 

C.  Với câu lệnh lặp với số lần biết trước: Câu lệnh được thực hiện lặp đi lặp lại cho tới khi điều kiện 

dừng lặp được thỏa mãn.  

D.  Bạn Trang sử dụng lệnh lặp với số lần biết trước thực hiện 

chương trình như hình bên.  

Câu 4: Dưới đây là mô tả các bước thực hiện cấu trúc lặp "lặp lại" 

để vẽ hình vuông. Hãy đánh giá tính đúng sai của các nhận định sau: 



- Chọn một nhân vật làm bút vẽ. 

- Để lại vệt khi di chuyển. 

- Lặp lại 4 lần: 

+ Di chuyển về phía trước một khoảng cách nhất định. 

+ Xoay 90 độ. 

- Sau khi lặp xong, nhân vật sẽ vẽ được một hình vuông. 

A. Cấu trúc lặp giúp chúng ta giảm thiểu việc viết lại các khối lệnh.  

B.  Chúng ta chỉ cần sử dụng một khối lệnh "di chuyển" để vẽ hình vuông.  

C.  Để vẽ hình vuông lớn hơn, ta chỉ cần tăng số lần lặp.  

D. Cấu trúc lặp trong ví dụ này là "lặp lại cho đến khi".  

Câu 5: Trong giờ học môn Tin học, lớp 8.5 học về Biến trong Scratch là những ô nhớ dùng để lưu trữ 

các giá trị, như số, chữ cái hoặc các giá trị logic (true/false). Chúng hoạt động như những hộp chứa mà 

ta có thể thay đổi nội dung bên trong. Việc sử dụng biến giúp cho chương trình trở nên linh hoạt và 

tương tác hơn. Để tạo biến trong Scratch, nhấp vào tab "Biến" trên thanh menu, chọn nút "Tạo một 

biến", nhập tên cho biến của mình. Cuối củng, chọn phạm vị để quyết định biến đó có được sử dụng 

cho tất cả các nhân vật hay chỉ một nhân vật cụ thể. Hãy đánh giá tính đúng sai của các nhận định sau: 

A.  Biến chỉ có thể lưu trữ số.  

B.  Mỗi biến chỉ có thể được sử dụng cho một nhân vật.  

C.  Biến có thể được sử dụng để lưu trữ điểm số trong một trò chơi. 

D.  Biến giúp chương trình trở nên linh hoạt hơn.  

TỰ LUẬN: 

Câu 1: Bạn An nhận được bài tập về nhà môn Tin. Hãy viết chương trình kiểm tra số a là số âm hay 

dương. Nhưng do hôm nay bạn An bị bệnh không đi học. Các bạn giúp bạn An hoàn thành bài nhé. Biết 

rằng giá trị của a nhập từ bàn phím và a là 1 số khác 0  

 

 

 

 

 

 

 

 

 

Câu 2: Hãy viết mô tả thuật toán tạo chương trình Scratch cho phép nhập 2 số m, n từ bàn phím, 

thực hiện hoán đối giá trị của 2 biến và thông báo giá trị của biến m, n sau khi đã hoán đối  

 

 

 

 

 

 

 

 

 



 

 

 

Câu 3: Hãy viết mô tả thuật toán tạo chương trình Scratch cho phép nhập Tổng, hiệu 2 số từ bàn 

phím, thực hiện tìm số lớn, số bé và thông báo giá trị của 2 số ra màn hình  

 

 

 

 

 

 

 

Câu 5: Nhà đầu tư cần đề bù một mảnh đất hình chữ nhật thuộc diện 

quy hoạch đền bù, mảnh đất đó thuộc nhà bạn Lan và nhà bạn  Linh 

như hình bên. Biết Chiều dài mảnh đất nhà bạn Lan hình chữ nhât là 

a, chiều rộng là b, mảnh đất nhà bạn Linh hình vuông có cạnh là b 

Hãy viết chương trình giúp nhà đầu tư tính được tổng diện tích cần đền bù cả 2 khu đất. Biết rằng a, b 

được nhập từ bàn phím 

 

 

 

 

 

 

Câu 6: Nhà bạn Ngân có một mảnh đất như hình bên với tổng diện tích là 80 m2 

với chiều dài là b là 12 m, chiều rộng a là 8 m. Hãy viết chương trình giúp bạn 

Ngân tính diện tích mảnh đất  màu trắng. Biết rằng mảnh đất đó  là hình 

vuông. 


